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Scope of work

Demonstrate how to implement the OneEye oscilloscope over the
UART (USB) interface

After configuring the OneEye UART Iinterface, a OneEye oscilloscope is
created. The signals are updated and sampled every millisecond. OneEye is
used to visualize the signal values.
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Introduction

» OneEye is a GUI that enables the creation of interactive Graphical User Interface. Graphical
elements can be drag from a toolbox and drop onto the GUI. The behavior of the created
GUI can be customized. Different communication interfaces like UART, Ethernet, CAN, DAS
can be used to interact with the embedded system

» SyncProtocol / ProtocolBB is a synchronous protocol that enables data streaming between
the target microcontroller and OneEye. It enables to open multiple communication channels,
provide packet acknowledge and packet checksum. Data are transported within a message
with a message ID and a message payload. See the OneEye help for more information.

Single frame

Coe | o | 1 T
0 | enbie | S | fewer | Poyiatieng |
& | rless(framenendstsl | checkaum peyiosd | Ghecksum header |
e | wemmen | emned |

Viessage length
Viessage payione
_ ... IMessage payload)

> Note: It is recommended to go through some of the basic tutorials listed in the help
embedded in OneEye (Menu: Help -> OneEye help). This enables a quicker ramp-up in the
OneEye concept and ensures a nice journey with OneEye
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Hardware setup

This code example has been developed for the
board KIT_A2G_TC334 LITE.

The board should be connected to the PC
through the USB port ( 1
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Configuration overview

In this configuration an oscilloscope running on the microcontroller is connected to the COM port.

In OneEye, two signals bb.in and bb.out are used to connect the COM port data stream to the BB protocol.
The BB protocol is configured to open a channel reserved for the oscilloscope. This channel connects to the
oscilloscope with the oscilloscope.in and oscilloscope.out signals.

BB protocol ‘

BB Oscilloscope Embedded

Oscilloscope Oscilloscope BB :
g P Protocol channel oscilloscope

Widget channel Protocol

-

Onetye Micro-controller
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Implementation - AURIX

Enabling the OneEye library

The OneEye library must be enabled by adding the following line to Ifx_Cfg.h:
#define IFX_OE_AL_USE_AURIX_ILLD

Configuring the OneEye Oscilloscope
A OneEye oscilloscope (Ifx_Oe_Osci) is an object that enable data sampling and provide triggering functionality.

The OneEye oscilloscope communication interface (Ifx_Oe_OsciBb) enables streaming of data and control of the
oscilloscope using the BB protocol (Ifx_Oe_SyncProtocol).
The OneEye oscilloscope is initialized with initOscilloscope() / Ifx_Oe_Osci_init().

The autoAddChannels parameter enables to automatically add channels for each created oscilloscope signal.
The sample period (samplePeriod) is set to 1ms and provides OneEye information about sample timing.

The triggerMode is set to automatic, note that this value can be changed from the OneEye oscilloscope interface
later.

The ifx_oe_osci.h file can be found in the Libraries\OneEye directory.

Adding signals to the oscilloscope

Oscilloscope signals are mainly pointers that the oscilloscope can use for data sampling. The signals are added using
Ifx_Oe_Osci_addSignal(). The function takes as parameter the signal name displayed by the oscilloscope, with an
optional unit string in parenthesis, the signal type which informs the oscilloscope how to read the pointer value and a
source pointer to the data. The last parameter corresponds to the g format used in case of fix point data, or O if not
used.
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Implementation - AURIX

Starting the oscilloscope

The oscilloscope is started with the function Ifx_Oe Osci_start().

Configuring the signal generator

A signal generator is used to provide the user with some value to read / write. The signal generator does
nothing more than incrementing two signals, signalA and signalB, stored in the structure g_signalGenerator
up to a maximum value before resetting them.

The initialization of the signal generator is done with initSignalGenerator ().

Running the signal generator and the oscilloscope

The signal generator is executed in the background loop every 1ms with processSignalGenerator(). To
ensure the timing, a deadline variable is periodically updated with Ifx_Oe_Time_add() to obtain the 1ms
period.

The oscilloscope runs in the same background loop with sampleOscilloscope() / Ifx_Oe_Osci_step(). This
function handles the triggering and sampling of data.

Note: the call to Ifx_Oe Osci_step() can be moved to an interrupt service routine if required by the
application use case.
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Run and Test

> After code compilation, flash the device using the Flash button @@ to ensure that the
program is running on the device

»  For this training, the OneEye application is required for visualizing the values. OneEye can
be opened inside the AURIX™ Development Studio using the following icon:

File Edit Source Refactor Navig'ﬂearch Project Debug Window Help
| )" E CKIE E E '.:} |:?:| #ﬁl - .) - | - ’l‘f::l l::_& {:j - -
|
v
Onekye — O x

> Clicking the OneEye

icon automatically
opens the OneEye
configuration for the
active project. If no
configuration exists, it
is created by AURIX™
Development Studio

OneEye Version 2.46.0
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Implementation - OneEye

In this training, the OneEye configuration is provided inside the Libraries folder. The following steps are
needed to configure the oscilloscope from a brand-new configuration.

Setup OneEye for editing

Select the OneEye menu “Options -> Edit mode” (if not already checked) to enable the edit mode.

Select the OneEye menu “View -> Browser box”, “View -> Property box” , “View -> Tool box” (if not
already checked) to display the browser, property box and tool box. Note that the box can be moved around.

Tool box a8 x Property box B8 x

Elaarsauge
Check Box

Path QObject Title

configuration
debugBox

OneEye Version 2.46.0 1105, 670
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Implementation - OneEye

Removing the default DAS interface

When the OneEye configuration is created by ADS, it is already setup with a DAS interface.
Select the interface in the Browser box and delete it with “right click and remove” as it is not required in

this example.

OneEye - m} X
File Options View Help
Tool box T X Property box g %
~
H Plugin Com Port: DAS
pacatas plugin PCom_DASHDAS

server-host-address |localhost

Check Box
server-name UDAS
O connect
clockees f [eos ]
N

Combo Box
system-key {ADS}

@ Dial
i Graph
i Graph Channel

Goan &
< >
Browser box g X
All ~
Path Object Title  *
signals
ayo
|l interface interface.
DAS Interace.
configuration
W
AL
< >

OneEyeVersion 2.46.0 1105, 670
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Implementation - OneEye

Configuring the UART interface: Signal creation
The first step is to create 2 signals to connect the received and transmit data over the UART.

Create a signal group and set its name property to bb.

Onekye - O X
File Options View Help
Browser box e x| Property box g x
Al v "
Signal: group
Path Ohbject Title { name |bb |
layout offset
configuration sccess
model-update-value-enabled O
user-data I:I
send-get-request ]
on-updated I:I
include-path l:l
include-as-read-only
< > Enum values
Tool box Browser box Match events hd

OneEye Version 2.48.0 937, 465
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Implementation - OneEye

Add two signals of type char into the bb group, name them in and out, and set their title property to
respectively BB in and BB out.

Onekye - O X
File Options View Help
Browser box g X Property box g X
Al v "
Signal: char
Path Object Title pf name [in |
“ signals
h
“ bb group type char
offset
out char BBout
configuration model-update-value-enabled O
P title [BBin |

send-get-request ]

on-updated

Enum values

Match events

< >

Connections

Tool box Browser box

OneEye Version 2.48.0 937, 465
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Implementation - OneEye

Configuring the UART interface: COM port
Right click in an empty area of the Browser box, and select Add child -> Interface. Then right click on the

created interface and select Add child -> com. Select the com item and set its device property to the COM
port connected to the AURIX board. Set the baudrate property to 115200 and click connect.

The COM port is now opened and ready for communication.

OneEye

File Options View Help

Browser box g X Property box g X

All w
Plugin Com Port: com

Path Object Title plugin PCom_Corezcom
“ signal
signats device COM17
bb group
layout »] baudrate 115200
~ interf, COM.COM1T
interface connedt

;ﬁam COM CORMIT
contiguration

< >

Tool box Browser box

OneEye Version 2.48.0 937, 465
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Implementation - OneEye

Configuring the UART interface: Transmit stream

Right click on the interface in the Browser box, and select Add child -> dataMessageHandler. Then right
click on the created dataMessageHandler and select Add child -> message to create a message item.
Configure the message with the id=0xFE, interval=0.001, send-on-new-data checked, dir=tx, stream
checked.

OneEye

File Options View Help

Browser box g X Property box g X
All w
Message: message
Path Object Title id |oxFE |
> signal
S interval [0.001 |
layout P
v interface COM.COM1T send-on-new-data
v dataMessageHandler dir x -
¥ MESSaEE irn
field bb.out type extended hd
¥ message 0xFF
length 0
field bb.in T = | |
<
com COM.COM1T P stream |
configuration
£ >
Tool box Browser box
OneEye Version 2.48.0 937, 465
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Implementation - OneEye

Right click on the message, and select Add child -> field.
Configure the field with name=bb.out, bit-pos=0, buffer=512.

Now, data will be transmitted over the UART each time the bb.out signal is written with some data.

Onekye

File Options View Help

Browser box JF X Property box 5 X
All ~
Message field:  field
Path Object Title name bb.out ]
> signal
signals Pl bit-pos |O |
layout
v interface COM.COM17 buffer |512 |
w
dataMessageHandler PR ket O
¥ Message OxFE
I field : oot
“ message 0xFF
field bb.in
com COM,CoM17
configuration
€ >
Toolbox  Browser box
OneEye Version 2.48.0 937, 465
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Implementation - OneEye

Configuring the UART interface: Receive stream

Right click on the dataMessageHandler and select Add child -> message to create a second message item.
Configure the message with the id=0xFF, interval=-1, dir=rx, stream checked.

OneEye

File Options View Help

Browser box JF X Property box 5 X
All -
Message: message
Path Object Title id |oxFF |
y
signals interval |-1 |
layout >
v interface COM.COM1T send-on-new-data [
v dataMessageHandler dir |rx vl
¥ message 0xFE
field bb.out type |extended v
b e
mes.s..age i length |O |
field bb.in
com COM.COM1T PLstream |
configuration
£ >
Tool box Browser box
OneEye Version 2.48.0 937, 465
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Implementation - OneEye

Right click on the message, and select Add child -> field.
Configure the field with name=Dbb.in, bit-pos=0.

Now each time data are received over the UART, the bb.in signal will be updated.

Onekye - O X
File Options View Help
Browser box g X Property box g X
Al v|
Message field:  field
Path Object Title name bh.in + -
: >
>
signals bit-pos |'U |
layout
v interface COM.COM17 buffer lo |
v dataMessageHandler buffer-as-pakeet 0
¥ message 0xFE
field bb.out
¥ Message 0xFF
I field : derbrsier
com COM,.COoM17
configuration
£ >
Tool box Browser box
OneEye Version 2.48.0 937, 465




Implementation - OneEye

Configuring the UART interface: Push button
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Drag and drop a pushButton widget from the toolbox onto the layout, configure it with title=Setup Serial

Interface, on-click={show.connection.ui}.

Communication interface setup ? X
Clicking the button now shows the COM port configuration window.
Plugin Com Port: com
plugin PCom_Caoretcom
OneEye
> device COM17
File Options View Help
baudrate 115200
Browser box g X Property bo
connect
All -
Plugin w
Close
- T [eex ]
signals .
Pr— L .
pushButten I = : up Se data-out I:I +
interface COM.COM17
configuration auto-connect I:I 2 -
title Setup Serial Interface
Setup Serial Interface user-data | |
enabled defing¢d-by-connection w
visible yES W
update-method on-new-data w
style-sheet
i = Pl on-click |{5how.connection.ui} |I v
Tool box Browser box < 2
OneEye Version 2.48.0 937,472
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Configuring the BB protocol
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Right click in an empty area of the Browser box, and select Add child -> protocolEngine. Then right click on
the created protocolEngine and select Add child -> protocol-core-bb. Connect the BB protocol stream to
the bb.in and bb.out signals by setting respectively the data-in and data-out properties. Set the name
property to BB-core. And set the timeout to 2000 ms so that frames are dropped after 2 seconds in case the

microcontroller is not answering.

OneEye

File Options View Help

Browser box

All

Path
signals
layout
interface

Object Title

COM.COM1T
.BB-core

~ protocolEngine
Iprotocol—corebb =

configuration

€

Tool box Browser box

OneEye Version 2.48.0 937,472

Setup Serial Interface

Property box
Plugin protocol core; protocol-core-bb
name |BB—core
plugin PProtocol_Corenbb
»1 data-in |bb.in
data-out |bb.out
timeout |2000
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Implementation - OneEye

Configuring the Oscilloscope: signals creation

Create a signal group and set its name property to oscilloscope.

OneEye - O X
File Options View Help
Browser box g ox Property box g ox
Al v ~
Signal; Egroup
Path Object : name |05cilloscope l |
¥ signals
e rou
aroup typ group
~ pscilloscope TIOTT offset |Dxﬂ |
in char .
out char aCCess | read-write ~ |
¥ layout model-update-value-enabled |
pushButton Setup Serial Interface title | |
» interface COM.COM17
> protocolEngine .BB-core user-data | |
fi ti i
contiguration Setup Serial Interface send-get-request |
on-updated | |
include-path | |
include-as-read-only
Enum values
Match events
Connections
< >
I —— W
Tool box Browser box
OneEye Version 2.48.00 1170, 559
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Implementation - OneEye

Add two signals of type char into the oscilloscope group, name them in and out, and set their title property
to respectively Oscilloscope in and Oscilloscope out.

OneEye - O X
File Options View Help
Browser box 2 X Property box 2 x
all v "
Signal; char
Path Object : name |in I |
v signal
siEnats type char
> bb group
hd i Eroup offset |Dxﬂ |
in Tt -
Ut char ACCEss | read-write k4 |
¥ layout model-update-value-enabled |
hButt Setup Serial Interf
. pushiution up Seniatintertace : title |05cilloscopein| |
» interface COM.COM17
> protocolEngine .BB-core user-data | |
fi ti ;
contiguration Setup Serial Interface send-get-request |
on-updated | |
Enum values
Match events
Connections
n: Decoder: BB-core
< >
W
Tool box Browser box
OneEye Version 2.48.00 1170, 559




Implementation - OneEye

Create the oscilloscope widget
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Drag and drop an oscilloscope widget from the toolbox onto the layout, set the oscilloscope properties data-
in and data-out to respectively oscilloscope.in and oscilloscope.out. Set the protocol-type property to
ProtocolBB. Set the unit-x property to s.

Onekye

File Options View Help

Browser box

configuration

<

Tool box Browser box

OneEye Version 2.48.0 1170, 559

all Oscilloscopein
oF signal A () A
B na
Path Object I W
> signals Vhlue: 865 (W)
W
layout 1} signal B
pushButton Setup Serial Interface v} 240 /Div
|~ _oscilloscope _ |Peeiiessepes Sl
> interface COM.COM1T
> protocelEngine .BB-care

¥:0.01 s/Div 0.0104835 5

— O s
Setup Serial Interface Property box e
~
Plugin widget: oscillozcope
Control
ntro . |
Refresh State - B -
data-in oscilloscope.in -
Run
- data-out oscilloscope.out -
Disabled
title | |
Buffer depth |E-l?_ |
user-data | |
samplinginterval |1 |
. . enabled defined-by-connection w
Sampling period () 0.001
Time/Div 10ms/Div v visible 5= e
Reset zoom style-sheet
Trigger
. . legend-pos top w
Single mode [] Single
Trigger mode | Automatic e ISR |lﬂ |
ope e protocol-type Protoco BB ~
Channel CHO: Signal A (V) division-y |10 |
Level offsety |5 |
time-per-division-x |0.002992999776482582 |
L |
Control Channel Save Into Hide 1 unit-x |5 | W
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Implementation - OneEye

Connect the oscilloscope widget to the BB protocol

Right click on the protocol-core-bb and select Add child -> target. Select the target item and set local-port
and remote-port to 3 to match the AURIX settings, set signal-in=oscilloscope.out, signal-
out=oscilloscope.in, forward=checked.

OneEye - O X
File Options View Help
Browser box = 4 Setup Serial Interface Property box g x
all w Oscilloscope in
Tarﬁet: tarﬁet
: 0: Control
Path Object e J local-port B |
> o5 |
signals Refresh State TR |3 |
> layout
. 1 [ 1Eun
> interface COM.COM17 ¥ 200 /Div signal-in |oscilloscope.out |
~ protocolEngine .BB-core
- signal-out |05cilloscope.in |
d h Bufferdepth |512 |
target e forward
configuration Sampling interval |1 | send-parent-value [
Sampling period (s)
Time/Div 10ms/Div ~
Resetzoom
Trigger
sSingle mode [] Single
Trigger mode w
Slope
Channel CHO
Level 0
£ >
¥:0.015/Div 0.000531915s Control || Channel Save Info Hide
Tool box Browser box
OneEye Version 2.48.0 1170, 559
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Implementation - OneEye

Test the oscilloscope

The oscilloscope Control tab provides configuration for the trigger and information about the oscilloscope state
(armed, triggered, uploading).

Click on the Control button.and the Refresh State button to retrieve the oscilloscope settings (channels,
timings, ...).

OneEye — [m| x
File Options View Help
lleofbex 2 _E Setup Serial Interface iy e E
"= Label - oscilloscope in
Target: target
Line Edit L~ ‘
Control
Emg&e, e
Ll Run signal-in 0sci
Disabled .
Logger Channel signal-out

_:\ forward
= Mux-Demux samplinginterval send-parent-value [ ]

res ’ -
~——— Mamed Pipe Client Sampling period (s) 0.01

Foe ]
Named Pipe Server Time/Div 15/Div ~
E Resetzoom
Ozcilloscope
$ Trigger
Oscilloscope Channel Singlemode [] Single
st v Trigger mode | Automatic ~
Slope Risingedge
Browser box g X
Channel CHO: Signal A (V)
All ~
Level
Path Object Title 2
~ signals
v bb Egroup

in char BEin
out char BBout W

X
< >
X 15/Div 0s Control hannel Save Infa Hide

OneEyeVversion 2.48.0 1310, 645




Implementation - OneEye

Test the oscilloscope
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In the oscilloscope Channel tab, click on the Channel button ‘ and check the visible check box for both
CHO: Signal A and CHL1: Signal B to display the two channels.

Set the Unit per div Y to 200 for both CHO: Signal A and CH1: Signal B.

Select the Pen color red for CHO: Signal A and blue for CH1: Signal B.

OneEye - O *
File Options View Help
Setup Serial Interface
Oscilloscopein
0: Signal A (V) Channel
¥ 200 (V)/Div
Value: 840 (V) Channel CHO: Signal A (V) ~
1: Signal B Signal Signal & (V v
3 200 [Div : 2 ™
Value: 330 Visible
Offseti o |
Offeety o |
unitperdiv | [200
Pen color red |
—
Penwidth 1
%:0.0512 5/Div 0.464155 Control I Channel I Save Info Hide

OneEyeVersion 2.48.0
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Implementation - OneEye

Test the oscilloscope

Click on the Control button ‘ check the run button ‘ , the values for signalA and signalB should be
updating in the oscilloscope.

OneEye - O X
Set the Time/Div value to Zoom All to o e i
configure the horizontal scale to use the full Setup Serial Interface
screen of the oscilloscope window. el
0: Signal A (V) ] Control
. ¥: ZD[IJ (V) /Div
The Buffer depth configures the Yobe: 60 1) ‘m —
. . 1: Signal B un
oscilloscope buffer depth, here 512 points 1520 o ] Stopoed
are used to fill the buffer. This value can be ’ | [eufferdeth :5”— :
. . . . Sampling interval 1

changed within the limit set by the software. e (3 (o0

Time/Div Zoom All v
The Sampling interval provides the —n
information whether to sample at each e
. . Single mode || Single
interval (1) or not (>1) to the oscilloscope. - =

Trigger mode | Automatic ~

Slope Rising edge

Channel CHO: Signal A (V)

Level

¥:0.0512 5/ Div 0.46415s . Channel Save Infa Hide
OneEye Version 2.48.0
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Implementation - OneEye

Advanced options

Advanced configuration can be added to the file Ifx_Cfg.h or ifx_oe_cfg.h to tune the oscilloscope
capabilities, this includes:

» IFX_CFG_OE_OSCI_MAX_NUM_OF_SIGNALS: the maximum number of signals that can be declared
by the user

» IFX_CFG_OE_OSCI_MAX_NUM_OF_CHANNELS: the maximum number of channels that can be
buffered

» IFX_CFG_OE_OSCI_NUM_OF_SAMPLES: the maximum number of sample per channel

Note: the memory used by the oscilloscope is mainly defined by
IFX_CFG_OE_OSCI_MAX NUM_OF _CHANNELS *IFX CFG_OE_OSCI_NUM_OF SAMPLES*4

Default values for the above mentioned macros are provided in ifx_oe_oscicfg.h under Library/OneEye.
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References

»  AURIX™ Development Studio is available online:
»  https://lwww.infineon.com/aurixdevelopmentstudio

%&%ﬂ > Use the ,Import..." function to get access to more code examples.

> More code examples can be found on the GIT repository:
»  https://github.com/Infineon/AURIX_code_examples

v

For additional trainings, visit our webpage:
https://www.infineon.com/aurix-expert-training

v

~

For questions and support, use the AURIX™ Forum:
https://www.infineonforums.com/forums/13-Aurix-Forum

v
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Trademarks

All referenced product or service names and trademarks are the property of their respective owners.

Edition 2022-06
Published by

Infineon Technologies AG
81726 Munich, Germany

© 2021 Infineon Technologies AG.
All Rights Reserved.

Do you have a question about this
document?
Email: erratum@infineon.com

Document reference
OneEye_UART_Oscilloscope_1
_KIT_TC334_LK

IMPORTANT NOTICE

The information given in this document shall in no
event be regarded as a guarantee of conditions or
characteristics (“Beschaffenheitsgarantie”).

With respect to any examples, hints or any typical
values stated herein and/or any information
regarding the application of the product, Infineon
Technologies hereby disclaims any and all
warranties and liabilities of any kind, including
without limitation warranties of non-infringement
of intellectual property rights of any third party.

In addition, any information given in this
document is subject to customer’s compliance
with its obligations stated in this document and
any applicable legal requirements, norms and
standards concerning customer’s products and
any use of the product of Infineon Technologies in
customer’s applications.

The data contained in this document is-exclusively
intended for technically trained staff. It is the
esponsibility of ustomer’s technical
departments to—evaluate the suitability of the
product for the intended application and the
completeness of the product information given in
this document with respect to such application.
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For further information on the product,
technology, delivery terms and conditions and
prices please “contact your nearest Infineon
Technologies office (www.infineon.com).

WARNINGS
Due to technical requirements products may
contain dangerous substances. For information
on the types in question please contact your
nearest Infineon Technologies office.

Except as otherwise explicitly “approved b
Infineon Technologies in a written\ document
signed by authorized representatives of\Infineon
Technologies, Infineon Teehnologies’ products
may not be used in—any applications where a
failure of the-product or any consequences of the
use thereof can reasonably be expected to result
n personalinjury.
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